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How to Use This Guide

This manual is organized in sections.  There are sections on installing and using TestTalker™, as well as providing information and tips on scanning, saving, and using TestTalker’s help system.  Emphasis is placed on how to insert answer blanks.  

Functions are noted in certain ways.  Items from TestTalker’s toolbar and menus are in bold.  Menus, Settings, and Keystrokes are listed in the Reference section of this guide.  Questions not answered by the guide may be found in TestTalker’s on-line help system, by calling Technical Support at 727 803-8600, or via email: SoftwareSupport@FreedomScientific.com.

Introduction

Welcome to TestTalker Teacher Edition

Thank you for purchasing TestTalker Teacher Edition.  TestTalker was developed by the Learning Systems Group of Freedom Scientific.

What TestTalker Does

TestTalker is a talking program that reads tests, forms, and worksheets.  It allows a teacher or administrator to scan and configure tests, forms, or worksheets so that a student or employee can complete the form electronically.  The person taking the test can both see and hear the material, ensuring a multi-sensory testing environment.  TestTalker is used with fill-in, extended answer, multiple choice, and true/false questions. 

Using TestTalker Teacher Edition, and a computer with a scanner, a teacher scans a test, form, or worksheet into the program.  The teacher cleans up any errors made during the scanning process, and then inserts the answer blanks.  The teacher can try out the test, form, or worksheet the way a student will use it.  After making any necessary modifications, the teacher saves the material.  The student completes the material using the TestTalker Student Edition.  The test can then be printed and graded. 

How TestTalker Works XE "How TestTalker works" 
TestTalker uses the same underlying technology as WYNN, Freedom Scientific’s innovative reading, writing, and studying program.  TestTalker uses OCR (Optical-Character Recognition) technology to convert scanned information into text.   It reads materials using IBM’s ViaVoice speech synthesizer.  TestTalker also highlights the material as it is being spoken.  The user can control the speed of reading, along with other aspects of the speech output.

Special Note for WYNN Users

WYNN XE "WYNN"  is Freedom Scientific’s innovative reading, writing, and studying program.  WYNN users will find TestTalker familiar, as TestTalker utilizes a similar tool-bar interface with easy-to-use, intuitive buttons.  

TestTalker files are not compatible with WYNN.  WYNN files may be imported into TestTalker by printing them to TestTalker’s virtual printer.  When in WYNN, select TestTalker Virtual Printer from the list of available printers in the Print dialog box.  This will send the WYNN document to TestTalker, which will then recognize and open the file.

TestTalker does not include the writing and study tools that WYNN has, such as Dictionary, Word Prediction, and Spell Checker.  It also doesn’t use as many editing features as WYNN.  TestTalker simply makes a copy of a test, form, or worksheet on the computer.  

TestTalker is used when a multi-sensory adaptation is desired for completing tests, forms, and worksheets, while WYNN is used for reading, writing, and studying.

Installing and Starting TestTalker XE "Installing and Starting TestTalker" 
System Requirements XE "System Requirements" 
To run TestTalker, your computer must meet the following minimum requirements:

· An IBM-compatible Pentium computer running at least 450MHz

· Windows 9.x, Me, NT, 2000, or XP

· For installation on NT4, Service Pack 6 is required

· 92 MB of RAM

· A CD-ROM drive

· A compatible sound card with speaker

· A supported TWAIN-compatible scanner

· A video card and monitor capable of VGA video in 800x600, high-color, 16-bit color mode or greater

Installing TestTalker

Instructions 

1. Place the TestTalker CD in your CD-ROM drive. The installation program should start automatically.  If the TestTalker installation wizard does not automatically display, go to Step 2. Otherwise, skip to Step 3.

2. Use the following procedures if the TestTalker installation wizard does not automatically display.

· From the Windows Start Menu, select Run. The Run dialog box displays.

· Type <x>:\SETUP.EXE in the text box provided, then click OK.

Note: <x> represents the drive letter for your CD-ROM drive.

3.   The Welcome to InstallShield® dialog box will appear.

3. Click the Next button.

4. Read and agree to the License Agreement by clicking Yes.

6.   Read the Readme file for late breaking information.  Click Next to continue.

7.  Fill in your name, company (or city) name, and serial number in the blanks when asked.  The serial number is located on the outside of your TestTalker CD-ROM packaging.  Click Next to continue.

8. Choose the destination location where you would like TestTalker 

 installed.  The default directory is C:\TestTalk.  Use the Browse button to change the destination, or type in the desired location and click Next.

Note:  
On Windows 2000, XP, and NT, when installing with administrative privileges, you may choose to install the application for “Anyone who uses this computer (all users)” or “Only for me (current user).”

Starting TestTalker XE "Starting TestTalker"  

TestTalker is started by double-clicking the TestTalker icon on your desktop, or by selecting TestTalker through the Windows Start menu.

How do I get Help?

Refer to the Help System section of this guide for detailed description of TestTalker’s Help system.  Access TestTalker Help through the following methods:

· Select Help from the file menu at the top of the screen. This will open TestTalker’s on-line help system.  You must have Internet Explorer 4.0 or later.
· Access context-sensitive help in a dialog box by right-clicking an item. Or click the question mark at the top right, then click on the specific item.
· Use the Reference section of this guide for an alphabetical list of TestTalker menus, commands, and other functions.
· Contact Technical Support at (727) 803-8600 or via email: SoftwareSupport@FreedomScientific.com.  Office hours are Monday through Friday 8:30 AM to 8:00 PM Eastern Standard Time.
When you call, be at your computer, have your documentation in hand, and be prepared to provide the following information:

· Product serial number used for registration.

· Product name and version number.

· Type of computer hardware you are using.

· Version of Windows.

· Exact wording of any messages on your screen.

· What you were doing when the problem occurred.

· How you tried to solve the problem.

TestTalker Help System XE "Help System" 
TestTalker has two types of help systems available.  One is TestTalker’s on-line help system.  The other is TestTalker’s context-sensitive help.

On-line Help System XE "On-line Help System" 
Access the help system by selecting Help from the menu.  TestTalker will display the help system in its own window.  An outline view of help contents is presented in the left side of the window.  The contents of a help topic are presented in the right side of the window.  To display help contents, click on the subject in the left window, and the contents will be displayed in the right window.  To find a specific item, the index or search functions may be used.  Information is also found by clicking on hyperlinks.  Text with a hyperlink is blue.  Clicking on the hyperlink will take you to information specific to the hyperlink term.

Context-Sensitive Help XE "Context-Sensitive Help" 
When in a dialog box, access context-sensitive help by clicking on the question mark in the upper right corner of the dialog box.  Then click on any item in the dialog box, and context-sensitive help will appear, usually a short statement or paragraph describing the function for which you are seeking help.  You can also access context-sensitive help with a right mouse-click, which will bring up the floating “What’s This?” button.  Click on that control to bring up the context-sensitive help message for that item.

Using TestTalker XE "Using TestTalker" 
Overview 

The following section presents a general overview of TestTalker including appropriate materials to use with TestTalker, the sequential steps followed, and the interface.

Materials to Use XE "Materials to use"  with TestTalker

TestTalker can be used with tests, forms, and worksheets.  It is appropriate for use with copyrighted materials, as the materials cannot be modified after being scanned into TestTalker.  You can use TestTalker with any forms that have fill-in, extended answer, multiple choice, and true/false questions. 

United States copyright law states "... it is not an infringement of copyright for an authorized entity to reproduce or to distribute copies of a previously published, non-dramatic literary work if such copies are reproduced or distributed in specialized formats exclusively for use by blind or other persons with disabilities."

Visit the following link for more information on copyright law:

http://www.loc.gov/nls/reference/factsheets/copyright.html
TestTalker is not designed to use with materials that contain geometric, mathematical, or scientific formulas.  These materials may not scan or be spoken correctly.

TestTalker is able to use tests, forms, and worksheets that are scanned into a computer.  TestTalker also can use PDF (Adobe® Portable Document Format), Microsoft Word, and other file formats.

Sequential Steps XE "Sequential Steps" 
TestTalker is used by following a logical sequence of steps.  

Steps the teacher follows (with TestTalker running):

5. Scan, import, or download a test, form, or worksheet into TestTalker.

6. Check the reading order.  Use Dynamic Zoning to re-define OCR zones to change the reading order if desired.  It is important that this be completed prior to steps #3 and #4, or changes made during those steps will be lost when TestTalker’s OCR software re-recognizes the document.
7. Clean up any errors in scanning using Clean-Up.

8. Insert answer blanks for Fill-in, Extended Answer, Multiple Choice, and True/False. 

9. Try out the test, form, or worksheet, as a student would, using Student Mode.

10. Erase answers put in by teacher (may print first to use as an answer key).

11. Save material to disk or other place where student has access.

Steps the student follows (with TestTalker Student Edition running):

12. Student completes materials using TestTalker Student Edition.

13. Student saves materials if desired.

14. Teacher or student prints material, which is graded by the teacher.

Interface XE "Interface" 
You will operate TestTalker using the toolbar located at the top of the screen.  TestTalker can also be operated using its menus and/or keystrokes.  Each toolbar consists of a number of buttons.  Buttons will be grayed out if not currently available, for example, before a test is scanned into the program.  Some modes use a different set of toolbar buttons.  For example, when in Clean-Up mode or in the Student mode, there are fewer buttons. 

Toolbar XE "Toolbar" 
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Above is a picture of TestTalker’s main toolbar.  TestTalker’s toolbar provides the tools necessary to use the program.  You insert answer blanks using the main toolbar.  Clean-up and Student Mode have their own toolbars.  All functions accessible on the toolbar are also accessible through TestTalker’s menus, which are found in the Reference section of this guide.

Read XE "Read"     [image: image2.png]



Above is a picture of the Read button.  Press the Read button and TestTalker reads the open document aloud.  TestTalker highlights material as it is read.  Press the Read button again to pause reading at the place where the cursor is located in the document.  Press the Read button again to resume reading.  Note that you can also press the Spacebar to start and pause reading.

Scan XE "Scan"     
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Above is a picture of the Scan button.  Press this button to begin scanning the page placed on the scanner.  Please refer to the scanning section of the TestTalker manual for more information and tips on the scanning process.  Note that TestTalker looks for underlines and automatically replaces them with Fill-in answer blanks when it scans.

Notes on Scanning

· Place the page on the scanner first (with print side down), then begin scanning.

· While the page is being scanned, a dialog box informs you that TestTalker is processing the page.

· To interrupt scanning, press the Cancel button in this dialog box.  There may be a slight delay before TestTalker interrupts the scanning process.

· TestTalker keeps you posted on the progress of the scanning procedure with a message in this dialog box, and describes the page’s orientation on the status bar located at the bottom left side of the screen.

· Once scanning is done, TestTalker displays the page on your screen.

· Errors in scanning are not unusual.  You should closely review all material scanned into the program for any errors.

New XE "New"     [image: image4.png]



Above is a picture of the New button.  Press the New button to create a new document.  Now scan materials into the document.  Use the New button if you don't want the next scanned page added to an open document, but instead want it put into a separate, new document.  If there are no documents currently open, you don't have to press the New button before scanning--just press the Scan button and TestTalker will automatically open a new document and put the scanned page into it.

Open XE "Open"     [image: image5.png]



Above is a picture of the Open button.  Press this button to open an existing document.  The “Select a file to open” dialog box appears with a list of files that have been scanned in and saved. Click on the file you wish to open and press Open. TestTalker will open PDF, Microsoft Word, and other files, plus its own file format.  TestTalker opens PDF files the same way it opens its own format (.ttk) files, using the Open button.  To open a Microsoft Word or other type of document, you print the document to TestTalker’s Virtual Printer.  The document is not actually printed, but converted to a file format TestTalker can use.  To do this while in Microsoft Word, for example, choose Print and select TestTalker’s Virtual Printer as your printer.  Then print the document.  TestTalker will automatically open. The Scanning progress box will appear while TestTalker recognizes the document.  The document will then be displayed in TestTalker.  This document can then be saved in the TestTalker format.

Close XE "Close"     [image: image6.png]



Above is a picture of the Close button.  Press this button to close the document in which you are currently working.  TestTalker will ask you if you want to save any changes you have made to the document.  These changes include any corrections to text you have made using Clean-Up.

Save XE "Save"     [image: image7.png]



Above is a picture of the Save button.  Press this button to save the document you are currently working in without closing it.  This will automatically save the document with its existing file name and location.  If it is a new document, the Save As dialog box will open, and you will be prompted to enter a file name.  TestTalker will save files in its default directory, C:\TestTalk\Teacher\Users\Shared\Docs, unless directed otherwise.  

Print XE "Print"     [image: image8.png]



Above is a picture of the Print button.  Press this button to print the document.  Selecting Print opens the Print dialog box.  Note: This button will be grayed out if you do not have a printer installed.

Print Preview XE "Print Preview"     [image: image9.png]



Above is a picture of the Print Preview button.  Press this button to preview what the printed document will look like.  Selecting Print Preview opens the Print Preview Dialog box.  Note: This button will be grayed out if you do not have a printer installed.
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Above is a picture of the Fill-in Plus button and accompanying drop-down menu.  Use this control to insert a Fill-in or Extended Answer blank.  Press the button and choose Fill-in (for single-line answers), 3-line Extended Answer, or 8-line Extended Answer.  
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Above is a picture of the Multiple Choice button and accompanying drop-down menu.  Use this control to insert multiple choice answer buttons in the document.  Click on the button and choose Auto-group 4 or Manual.  With these options, multiple choice answer buttons are grouped in groups of 4 or more, or not grouped at all.  Grouping multiple choice buttons means that the user may select only one answer button in a group of buttons.  

True/False    [image: image12.png]



Above is a picture of the True/False button.  Use this control to insert true/false answer buttons in the document.  True/False answer buttons are automatically grouped.  In other words, only one answer button may be selected by the user when answering the question.

Clean-up/Close Clean-up    [image: image13.png]
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Above are pictures of the Clean-up and Close Clean-up buttons.  Press the Clean-up button to “clean up” any errors that occurred during the scanning process.  In Document Clean-up mode, you see both the Exact View and the Text-only View of the document.  The Text-only View appears on top, with the Exact View on the bottom.  Completing Clean-up ensures that the document will be spoken correctly by TestTalker.  Note that Clean-up does not change the appearance of the document scanned into the program; it only changes the way the document is read aloud.  

Student    [image: image15.png]



Above is a picture of the Student button.  Press this button to view and try out the document the way student will use the TestTalker Student Edition.  

Menus   
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 XE "Menus" 
Above is a picture of the menus that appear at the top of the program.  Click a menu, and a list of commands appears in a drop-down menu.  Commands that appear grayed out are not currently available.  Commands that have an ellipsis after them (…) open a dialog box when selected.  

Opening PDF, Microsoft Word, and Other Files

TestTalker is able to open existing PDF, Microsoft Word, and other types of files without having to scan them.  To open a PDF file, simply use the Open button and change the "Files of type" to Adobe PDF Documents.  To open a Microsoft Word or other type of document in TestTalker, first open the document in its original software.  Then, print the document to TestTalker’s Virtual Printer, a special print driver to convert these files into compatible format.  Select TestTalker’s Virtual Printer from the list of printers in the Windows print dialog box, and select Print.  TestTalker will open and display its scanning dialog box while it is recognizing the document.  Below is a picture of the Print dialog box with TestTalker’s Virtual Printer selected.
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Scanning XE "Scanning" 

Scanning is the process of taking a picture of a printed document so that you can keep it on your computer.  Optical Character Recognition (OCR) is the process of converting the scanned image into computerized text.  The OCR software is built into TestTalker.  All you need is a scanner.  

When you tell TestTalker to scan, it first tells the scanner to scan the page.   The scanner works like a copy machine, only instead of making a paper copy, it sends the copy to your computer as a picture of the page.  TestTalker’s OCR software performs intelligent recognition of the text on the page, turning the picture of the page into letters and words.  Then, TestTalker can read the text aloud.

Before You Scan

· Your scanner should be turned on and connected to your computer.

· You should have installed the scanning software that came with your scanner.

· TestTalker should be running.

Note: 
Scanners require that the document to be scanned be placed on the scanner in a specific way.  Look for an arrow or other mark on your scanner, or refer to your scanner’s documentation to show you where the top of the page should be.  TestTalker will automatically orient the document correctly if the top of the page is not where it should be (if the document is sideways or upside down), but this adds time to the scanning process.

Scan a Page

DO NOT use your scanner’s Scan button when using TestTalker. TestTalker has its own Scan button on the toolbar.

15. Place a piece of paper on the scanner glass with the print facing down.  Orient the page where your scanner indicates the top should be.

16. Click the Scan button on the toolbar.  TestTalker will begin scanning.  You will hear the scanner head moving along the paper, and TestTalker will put a progress message on the computer screen.  When finished, the document appears in TestTalker.

Below is a picture of the processing box that appears while TestTalker is scanning, preparing, and recognizing a document.
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Scanning of Different Formats

You may scan in one page or many pages, depending on the length of the test, form, or worksheet.  TestTalker has several different scanning modes and options.  Usually you will use TestTalker in its default mode, in which each page is immediately available for viewing. 

If you want to change any aspect of the scanning, you will do so with the Scanning Options XE "Scanning Options" .  Access Scanning Options by selecting it from the Tools menu.  Select the first command, which is Scanning Mode.  Select the mode desired, and press OK.

Scanning a single page:  Place the single sheet in the scanner, and press the Scan button, or select Scan from the menu.  This uses the default mode, Scan and Read.

Scanning multiple pages XE "Scanning multiple pages" :  TestTalker has several scanning modes that let you scan a large group of pages more quickly and efficiently.  For example, using the Large Batch XE "Large Batch"  mode divides the scanning process into two parts.  (1) Scanning the pages, and  (2) processing and recognizing the pages.  First TestTalker will scan all the pages, prompting you when you need to put the next page on the scanner.  If you have an Automatic Document Feeder (ADF), TestTalker will prompt you if the feeder is empty.  When all the scanning is done, you have TestTalker recognize the pages.  This is the lengthier part of the process, and you don’t need to be present while TestTalker does the recognition step.

Express Batch XE "Express Batch"  mode is faster, but skips the prompts to put each new page on the scanner.  You must watch and listen for the scanner head to reach the bottom of the glass, and then return to the top.  In those few seconds, you need to place the new page on the scanner glass, or turn the page of the book.  If you have an ADF, you will not need to place a new page on the scanner, as the ADF will do it for you.  The scanner keeps scanning until you press Escape.  Just as with Large Batch, once scanning is completed, TestTalker will recognize the pages while you do something else. 

Dynamic Zoning XE "Dynamic Zoning" 
Dynamic Zoning is used to change the reading order of a document.  For example, it may be desired that TestTalker read columns, instead of across a document from left to right.  Using Dynamic Zoning, the reading order of the document can be user-specified.  Not selecting a specific area will cause TestTalker to ignore this area when speaking a document. You may want TestTalker to ignore graphic images, headings, page numbers, or other text or symbols.

It is important that the user carefully defines the zones and places them in the order to be read.  Zones will be read in the sequential order in which they are placed in the document.  Before you begin using Dynamic Zoning, you should first check the reading order by pressing the Read button.  

If changing the reading order is desired, use Dynamic Zoning.  Decide on reading order first, then draw the new zones on the page in this order.  You will finish the process by having TestTalker re-recognize the document.  That "cements" the new zones in place.  

If the reading order is unsatisfactory after placing the zones, select Revert to Original Zones or Erase New Zones from the Dynamic Zoning submenu and begin again.
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The picture above shows dynamic zoning in use.  Note the headings were not selected as reading zones.  This means that TestTalker will ignore these items, and they will not be read.

If there are underlines in the document, TestTalker will try to turn them into Fill-ins when it re-recognizes the document (unless you unchecked the "Convert underlines to fill-ins" box in the Scanning Options dialog).

Important: Dynamic Zoning should be completed prior to Clean-up and inserting controls.  Dynamic Zoning requires that the document be re-processed by TestTalker’s OCR software.  Doing this will remove corrections made in Clean-up and remove any answer blanks or buttons that you inserted into the document.

To use Dynamic Zoning:

1. Select Dynamic Zoning from the Tools menu.

2. Select Enable Dynamic Zoning and Show Current Zones from the submenu that appears. The current zones, which is how TestTalker will read the document, appear surrounded by blue boxes.

3. Select Dynamic Zoning from the Tools menu, then Re-define Zones on Current Page from the submenu.  The blue boxes defining the current reading order disappear and the cursor changes to a crosshair with a small letter 'z' in it.

4. Click and hold the mouse button.  Drag the cursor over the first desired zone, making sure that all text to be included in that zone is contained within the red selection box.

5. Release the mouse button to set the first zone.

6. Repeat steps 4 and 5 to set each subsequent zone.

7. Select Re-recognize Document from Dynamic Zoning in the Tools menu.  The Scanning dialog box appears while TestTalker re-recognizes the document.  TestTalker completes re-recognizing the document and returns you to regular mode.

8. Press the Read button to check the newly-defined reading order.

9. If unsatisfactory, select Revert to Original Zones or Erase New Zones from the Dynamic Zoning submenu, and repeat steps 3-8 until the desired reading order is established.

Clean-Up XE "Clean-up" 
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Above is a picture of the Clean-up toolbar.  Clean-up provides the tools necessary to correct OCR errors that may occur in the document during scanning.  This ensures that the document will be spoken correctly by TestTalker when the student completes the test, form, or worksheet.

In Clean-up, you view both the Exact View XE "Exact View"  of the document and the Text-only View XE "Text-only View"  of the document.  The Text-only View appears on top, with the Exact View on the bottom.  The Text-only View is what TestTalker uses to read aloud, therefore, you should edit this View if the text does not match the Exact View.  Note that Clean-up does not change the appearance of the document scanned into the program, only how the text will be spoken. 

Important:  Before you begin Clean-up, have TestTalker speak the document by pressing the Read button.  This is a useful way to find OCR errors that occurred during scanning.  It is important to ensure that TestTalker is reading the document in the desired order.  If TestTalker is not reading the document in the desired order, use Dynamic Zoning to change reading order.  Refer to the Dynamic Zoning section of this manual for detailed information on how to use this function.

Below is a picture of TestTalker when in Clean-up mode.  Note that the Text-only View appears on top and the Exact View on bottom.
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Important:  It is important to correct errors in a document in a specific way so the document will be spoken and highlighted correctly by TestTalker: When correcting errors, do not delete the whole word or item to be corrected.  First, type in the corrections, then delete the errors.  Deleting the entire item and retyping it would erase the link that TestTalker uses to highlight the item when reading.

To use Clean-up XE "Document Clean-up" :

17. Press the Clean-up button on the tool bar. TestTalker will enter Clean-up mode.

18. Place the cursor over the Text-only View, which is on top, and click the mouse button.

19. Scroll through the Text-only View of the document looking for OCR errors.  Compare with the Exact View of the document on the bottom.  A pink box will highlight the location of the text in Exact View.

20. Correct OCR errors by placing the cursor next to the error and clicking the mouse button.  This will place the insertion cursor next to the error.

21. First, type in the correct characters in a word.

22. Then delete the incorrect characters.  Be sure not to delete the whole word--there must always be at least one character remaining in each word for TestTalker to use as its link between the spoken and highlighted text.  It doesn't have to be a character from the original word.  You can delete all but one original character, then type in new characters, then delete the last original character, and TestTalker will keep its link between spoken and highlighted text.  But if you delete that last character before typing in new characters, the link is gone.  (Think of it as a lifeline: you always need at least one strand of the rope.  You can add new strands, then remove any strands, old or new, as long as one strand is remaining.  But you can't remove all the strands, then throw new ones, because there is nothing to grab onto in the meantime.)

23. Repeat steps 4, 5, and 6 for any observed OCR errors.

24. Press the Close Clean-up button to exit Clean-up mode.  The main toolbar will appear.

25. Press the Save button to save your corrections.
Common OCR errors:  Errors are not unusual during the OCR process.  Random characters may occur from trying to detect images, smudges, or streaks on a poor copy.  The quality and contrast of the original document will impact the accuracy of the OCR process.  Whenever possible use an original document as opposed to a copy.  

Other errors may occur when the OCR engine identifies one character or symbol as another.  For example, numbers or letters in circles can be mis-identified.  The letters “in” may be mis-identified as “m” and visa versa.  Due to a wide range of type styles, fonts, and reproduction quality for documents you are likely to encounter, not all words will be correctly identified with every scan.  

Using the OCR Correction Editor: Using TestTalker’s OCR Correction feature, you can apply global corrections for any text string to your document.  Use TestTalker’s OCR Correction Editor, on the Tools menu, to correct any words that TestTalker’s OCR engine has not correctly identified.  To make changes to the OCR text, first open the OCR Correction Editor. Within the OCR Correction dialog box, click the Add button to add a word to the Word List, then click “Apply to Current Document.”  The changes will be applied to the current document.  Note that the OCR Correction Editor only recognizes whole words for correction.  

Controls XE "Inserting Controls" 

 XE "Controls" 
The heart of TestTalker is the ability to add answer blanks to a scanned test or form.  You can insert answer blanks for True/False, Multiple Choice, Fill-in, and Extended Answer formats.  See each section below for details about how to insert the answer blanks for that type of question.  

Controls are toggled on and off.  When you are finished inserting one type of control, click that control's toolbar button again to exit that control mode.  When a control is selected, the button will appear pressed-in.   To modify answer blanks or buttons, you must first exit the insert controls mode.

Important:  Do not place controls to the far right, left, top, or bottom of the screen/page as they may be outside the printable area.  Make sure that answer blanks or buttons do not cover up any of the text in the document. Also, make sure to save the document after inserting the controls. 

Fill-in Plus XE "Fill-in Plus"     [image: image22.png]=
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Above is a picture of the Fill-in Plus button and the accompanying drop-down menu.  Fill-in Plus allows you to insert answer blanks depending on the size of the answer.  Fill-in, 3-line Extended Answer, and 8-line Extended Answer blanks are options.

TestTalker may automatically insert a Fill-in answer blank where it recognizes an underline in a document.  If TestTalker inserts answer blanks where they are not desired, follow the steps below on how to delete them.

TIP:  
You may want to insert a Fill-in blank for students to type in their name. 

Below is a picture of  3-line and 8-line Extended Answer blanks inserted 

in a document.
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 XE "Multiple Choice"     

Above is a picture of the Multiple Choice button and the accompanying drop-down menu.  Multiple choice buttons may be grouped or not.  Grouping multiple-choice answer buttons means that only one answer may be selected by the student in a group of answers.  TestTalker will automatically group sets of 4 answer buttons if Auto-group 4 XE "Auto-Group 4"  is selected.  Select Manual XE "Manual"  if no grouping is desired or if there are more or fewer than 4 answers from which to choose.  Not grouping answer buttons allows the student to select more than one answer in a group of answers (for "choose all that apply" type of question).  If you are grouping more or fewer than 4 answers, choose the Manual option from the Multiple Choice drop-down options, then use the Group Buttons XE "Group Buttons"  option from the Tools menu.  Multiple Choice answer buttons also may be aligned by using the Align Answer Blanks function on the Tools menu.

Below is a picture of Multiple Choice answer buttons being inserted into a document.
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Note:  Answer buttons should be placed either next to, or on top of, the corresponding letter or number of the potential answer.

True/False XE "True/False"     [image: image26.png]



Above is a picture of the True/False button.  True/False answer buttons are used in groups of two: one for true, one for false.  TestTalker automatically groups true/false answers so the student can only select one.

Working with Controls

TestTalker’s answer blanks and buttons are first inserted, then can be modified if needed.  Answer blanks and buttons may be modified for size, reposition, and/or alignment.  They also may be deleted.  Multiple Choice items may be grouped.  Following are the steps necessary to insert and modify controls.

To insert answer blanks XE "insert answer blanks"  or buttons:

26. Click the Fill-in Plus, Multiple Choice, or True/False button.

Fill-in Plus

Select Fill-in XE "Fill-in" , 3-line Extended answer XE "3-line Extended Answer" , or 8-line Extended answer from the Fill-in Plus menu XE "8-line Extended Answer" .  The cursor will change to a crosshair.  Below are pictures of  Fill-in and 8-line Extended options being selected from the Fill-in Plus drop-down menu.
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Multiple Choice

Choose Auto-group 4 or Manual from the Multiple Choice menu.  The cursor will change to a crosshair.  Below are picture of Auto-group 4 and Manual being selected from the Multiple Choice drop-down menu.
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27. Use the mouse to position the cursor where you want the answer blank or button to appear in the document. 
28. For Fill-in answer blanks, click, and hold down the mouse, dragging from upper left to lower right to the desired size.  Let up on the mouse button and the answer space appears as a red box.  

For Multiple Choice and True/False answer buttons, position the crosshair where you want the button to appear and press the mouse button.  The control appears at the center of the crosshair.

To delete an answer blank XE "delete an answer blank"  or button (be sure to exit the insert mode for the control before doing this):

29. Move the cursor over the answer blank or button.

30. Click once to select the answer blank or button.

31. Select Delete from the Edit menu, or press the Delete button on your keyboard. 

To resize a Fill-in answer blank XE "resize a Fill-in question blank" :

32. Click the Fill-in Plus button again to exit Fill-in Plus mode.

33. Move the cursor over the red Fill-in or Extended Answer blank.

34. Click once to select the answer blank. 

35. Position the cursor over one of the black dots on the outer edge of the answer blank.  The cursor will change to a resizing cursor, a double-pointed arrow.

36. Click and hold the mouse button.  Drag in the direction you wish to resize the answer blank.  Release the mouse button when the answer blank is the desired size.  

To reposition an answer blank XE "Reposition an answer blank"  or button:

37. Move the cursor over the answer blank or button.  The cursor changes to a red, four-pointed arrow (also known as a Maltese cross).

38. Click and hold down the mouse button.

39. Drag the answer blank or button with the mouse to the desired position.

40. Release the mouse button.

To Align answer blanks XE "Align answer blanks"  or buttons XE "Align Answer Blanks" :

41. Position the cursor above and to the left of the answer blanks or buttons to be aligned.

42. Press and hold the mouse button and drag the selection box down and right to include all the answer blanks you want aligned.

43. Select Align Answer Blanks on the Tools menu.

44. Choose either Align Left XE "Align Left"  or Align Top XE "Align Top" .  The selected answer blanks or buttons will align in a vertical column to the left, or in a horizontal row to the top depending on which option is chosen.

To group XE "Group"  any number other than 4 Multiple Choice answer buttons:

45. Follow the steps for inserting Multiple Choice answer buttons.

46. Select Group Buttons from the Tools menu.  The cursor will change a dotted rectangle with a small arrow in it, which is the grouping cursor. 

47. Position the cursor near the Multiple Choice answer buttons to group.

48. Press and hold the mouse button and drag the mouse over the buttons you want in a group.

49. Release the mouse button and the answer buttons are now grouped.

Student Mode XE "Student/Teacher Mode" 
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Above is a picture of the Student Mode toolbar.  The Student Mode in the Teacher Edition of TestTalker allows the teacher to view and try out the document the way a student will use TestTalker Student Edition.  The Student Mode also allows you to create an answer key for checking completed materials.  It is recommended that you have TestTalker speak the material by pressing the Read button, as a student would, pausing reading, and entering the answers as you proceed.  TestTalker is able to read completed answer blanks in the order they appear in the question.

Taking the Test XE "Taking the Test" 
To try the test as a student:

50. Press the Student button on the main toolbar and the Student toolbar appears.  

51. Position the cursor over the desired answer blank or button.  For Multiple Choice and True/False questions, the cursor changes to a pointing hand.  For Fill-in and Extended Answers, the cursor changes to an insertion bar.  

52. Press the mouse button to select answers on True/False and Multiple Choice answer buttons, or to enter text on Fill-in and Extended Answer questions.  The Tab key may be used to move to the next answer blank.  Note that when in a Fill-in or Extended Answer, the blank changes from red to yellow.  The answer blank remains yellow after an answer has been entered.  This provides a clear indication of which questions have already been answered and which are yet to be answered.

53. Fill in all the correct answers so that you will have an answer key.

54. Press the Teacher button to switch back to the main toolbar.

55. Press the Print button to print an answer key.

56. Save the answer key if desired.  Select Save As from the File menu and type the desired name of the answer key in the File Name edit box.  Select a name to clearly specify that this is the answer key, for example “sciencetestkey.ttk.” 

57. Be sure to erase the answers by selecting Erase Answers from the Edit menu.
58. Save the test where the student will have access to it.  The default location is TestTalk\Teacher\Users\Shared\Docs.  Select Save As from the File menu and type the desired name of the test in the File Name edit box, for example “sciencetest.ttk.” Refer to the Saving to Disk section of this guide for more details.

Functions available in Student Mode

Several unique toolbar items are available from the Student Mode toolbar.  These same functions will be available to the student when using TestTalker Student Edition.  You must be in Student Mode to use these functions.  These functions provide options for cutting, copying, and pasting text within answer blanks, and moving from page to page in multi-page documents.

Note: 
These commands do not work on the text of the questions, but only on text in the fill-in answer blanks.

Cut XE "Cut"     
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Above is a picture of the Cut button.  Use the Cut button to remove or delete portions of answer text.

To cut text from the answer:

59. Position the cursor over the desired place in the document.

60. Press and hold the mouse button.

61. Drag the mouse to highlight the desired item(s).

62. Release the mouse button to make your selection.  The Cut button is now active.

63. Press the Cut button to delete the selection.

Note that you can also use the standard CTRL+X shortcut to Cut text, or select Cut from the right-click mouse options.  

Copy XE "Copy"     [image: image33.png]



Above is a picture of the Copy button.  Use the Copy button to copy text

64. Position the cursor over the desired place in the document.

65. Press and hold the mouse button.

66. Drag the mouse to highlight the desired item(s).

67. Release the mouse button to make your selection.  The Copy button is now active.

68. Press the Copy button to copy the selection.

Note that you can also use the standard CTRL+C shortcut to Copy text, or select Copy from the right-click mouse options.  

Paste XE "Paste"     
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Above is a picture of the Paste button.  Use the Paste button to paste copied text.

69. Position the cursor where the copied text is to be placed.

70. Press the mouse button to place the cursor.

71. Press the Paste button, and the desired text is placed in the document.

Note that you can also use the standard CTRL+V shortcut to Paste text, or select Paste from the right-click mouse options.  
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Above is a picture of the Go To button.  Use the Go To button to go to a specific page in a document.

72. Press the Go To button.  The Go To Page dialog box appears.

73. Go to a specific page number by entering a page number, and pressing Go, or Press Next Page or Previous Page.

Note that you can also use the standard CTRL+G shortcut to Go To a page.  

Teacher Mode    [image: image36.png]



Above is a picture of the Teacher button.  Press this button to switch back to Teacher mode.

Saving to Disk XE "Saving to Disk" 
After inserting controls, the teacher saves the completed material by pressing the Save button or Save As from the File menu.  TestTalker saves files in its default directory unless otherwise specified.  TestTalker’s default directory is C:\TestTalk\Teacher\Users\Shared\Docs.

For a student to complete the test, the document must be saved where a student will have access to the document using TestTalker Student Edition.  The student opens and completes the document using TestTalker Student Edition.  The student then saves and/or prints the completed materials for checking. 

A student’s completed material can be identified in a number of ways.  Below are a couple of suggestions:

1. Instruct the student to enter their name in a Fill-in answer blank inserted by the teacher for this purpose, then print the completed material.

2. Instruct the student to name and save the file, using either their own name, or a specific file name designated by the teacher.  

Important:  Ensure that completed materials are saved under different names to prevent TestTalker from overwriting previously saved documents. 

Student Completion

The students access the created test using TestTalker Student Edition.  If you want to do group testing you will need multiple copies of TestTalker Student Edition because you need a separate copy for each installed computer.  However, if you are only using one computer, multiple students can complete the same test a single copy of TestTalker Student Edition.

TestTalker files may be saved on and accessed from floppy disks, a computer’s hard disk, or network drives.

The teacher decides on a specific way to identify the students test, for example, by a name or number.  Once a student opens a test, the teacher should ensure that the student has named and saved the blank test using this identifier.  The teacher should encourage the student to save the document often during completion.

The student follows the steps below to complete a test:

1. TestTalker Student Edition is opened.

2. Using TestTalker Student Edition, the student opens the document specified by the teacher by pressing the Open button on the toolbar. This brings up the “Select a file to open” dialog box.

3. Use “Look in” to tell TestTalker what folder to look in to find the file to open.  The default directory is C:\TestTalk\Student\Users\[name of student]\Docs.  The student selects the desired file by clicking on it with the mouse.  Click on the desired file and click the Open button in the dialog box.  The file may also be opened by double-clicking on the file, or by typing the name of the file in the File name edit box and clicking the Open button.

4. The student completes the test.

5. The student saves the completed test by selecting Save As on the File menu, and typing in the file name specified by the teacher in the File Name edit box.
6. The student prints the completed material with the Print button on the tool bar and gives it to the teacher for checking.

Contacting Freedom Scientific

Freedom Scientific offers a variety of technological products and services supporting individuals with special needs.  We always welcome input from our product users.  Freedom Scientific may be contacted in the following ways:

For information regarding products and services please visit our website:

www.freedomscientific.com/wynn

By mail and phone:

Freedom Scientific

11800 31st Court North

St. Petersburg, FL 33617

(888)-223-3344

For technical support:

Technical Support telephone: (727) 803-8600

Technical Support email: SoftwareSupport@FreedomScientific.com" SoftwareSupport@FreedomScientific.com
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Reference XE "Reference"  

This section lists definitions of terms used in this guide.  It also contains an alphabetical list and description of every menu item and dialog box entry that appears in TestTalker.  Each item has the following:

1. What.  The name of the command or control as it appears in the toolbar, menu or dialog box.

2. Where (in parentheses).  In which menu and/or dialog box the command appears. 

3. Shortcut (in parentheses).  The Windows access key you can use for the command.

4. Description.  The explanation of what the control or command does, what the default settings are, and any important references.

Below is a table of TestTalker menu commands.  The menu lists the commands available and the menus in which they appear.

	File
	Edit
	Scan
	Insert
	Tools
	Window
	Help

	New
	Undo
	Scan
	Fill-in
	Start Reading
	
	Search for Help On

	Open
	Cut
	Scan and Replace
	Essay
	Dynamic Zoning
	
	TestTalker Help

	Close
	Copy
	Scan and Insert
	Multiple Choice
	Document Clean-up
	[Open Documents]
	About TestTalker

	Save
	Paste
	Scanner Selection
	True/False
	OCR Correction Editor
	
	

	Save As
	Delete
	Color Scanning
	
	Pronunciation Editor
	
	

	Page Setup
	Select All
	Recognize Columns
	
	Word Count
	
	

	Print Preview
	Font
	2-page Scanning
	
	Scanning Options
	
	

	Print
	Erase Answers
	
	
	Speech Options
	
	

	Properties
	Go To Page
	
	
	Group Buttons
	
	

	[Recently Accessed Documents]
	Move Page
	
	
	Align Answer Blanks
	
	

	Exit
	Delete Current Page
	
	
	Check as Student
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	


2-page Scanning XE "2-Page Scanning"  (Scan Menu item) (in Scanning Settings dialog box) (2).  This setting allows TestTalker to scan two side-by-side pages of an open paperback book (or other book in which both facing pages fit on the scanner) in a single scan.  TestTalker will store the pages separately, with separate page numbers.  This allows the page numbers in your document to match the page numbers in the scanned book.  After scanning, TestTalker will read the first page first, and then read the second page.  The default for this item is Off.

3-line Extended Answer (Insert, Extended Answer, 3-line Menu item).  Select this control to insert a 3-line extended answer blank.  Position the cursor at the place in the document you wish to insert the answer blank.  Press and hold the left mouse button, and drag.  Release the mouse button, then the 3-line extended answer blank will be the desired size.

8-line Extended Answer (Insert, Extended Answer, 8-line Menu item).  Select this control to insert an 8-line extended answer blank.  Position the cursor at the place in the document you wish to insert the answer blank.  Press and hold the left mouse button, and drag.  Release the mouse button, then the 8-line extended answer blank will be the desired size.

About TestTalker (Help Menu item) (A).  This menu command provides some basic information about TestTalker including the version number, serial number, and registered user.

Add XE "Add"  (button) (in Pronunciation Dictionary dialog box) (in OCR Corrections dialog box).  The button that is pressed to add an item or word to TestTalker’s Pronunciation Dictionary or OCR Corrections word lists.

Align Answer Blanks (Tools menu item) (A).  The command to use to align answer blanks or buttons to the left, in a vertical column, or to the top, in a horizontal row. 

Align Left (Tools, Align Answer Blanks menu item) (L) (CRTL+L).  The command that aligns answer blanks or buttons to the left in a selection box, in a vertical row.  
Align Top (Tools, Align Answer Blanks menu item) (T) (CTRL+T).  The command that aligns answer blanks or buttons to the top in a selection box, in a horizontal row.  
Answer Blanks:  Fill-in, 3-line Extended Answer, and 8-line Extended Answer spaces inserted into a document.

Answer Buttons:  True/False and Multiple Choice answer spaces inserted into a document. 

Apply to Current Document XE "Apply to Current Document"  (in OCR Correction dialog box) (P).  Select this button to have TestTalker apply corrections from its list to the open document.

Auto-group 4 (Insert, Multiple Choice Menu item) (A).  Use Auto-group 4 to automatically group four multiple-choice answer buttons together when you insert them.  Grouping answer buttons allows the student to select only one answer in a group of four possible answers.

Bottom Boundary XE "Boundary"  (in Scanning Settings dialog box) (M).  The Left, Right, Top, and Bottom boundaries determine how much of the page TestTalker should recognize, by defining the distance from the side of the page.  This tells TestTalker to ignore anything outside that boundary.  The standard setting for all four boundaries (left, right, top, and bottom) is zero, which means that the entire page will be scanned and recognized.

Cancel XE "Cancel"  (button) (ESC) (C).  Closes any dialog box without saving any changes made.

Case Sensitive XE "Case Sensitive"  (in Pronunciation Dictionary dialog box) (in OCR Correction dialog box) (E).  Check this field if you want TestTalker to perform a case-sensitive replacement.  The default for this setting is unchecked, that is, not case sensitive.

Check As Student XE "Check As Student"  (Tools Menu item) (C).  Select this command to try the test as a student would.  This option also allows creation of an answer key. After completing the test, print the document for an answer key.

Clean-up/Document Clean-up:  The mode entered when “cleaning-up” OCR text errors that occur during scanning.  It provides a view of the text in a split screen format, with the Text-only View, as converted by OCR in the upper window, with the Exact View of the document in the bottom window.  Accessed by pressing the Clean-up button on the toolbar or accessing Document Clean-up from the Tools menu.

Close XE "Close"  (tool bar button) (File Menu item) (CTRL+W) (C).  Select Close to close the document you are currently reading.  When you select Close, TestTalker asks you if you want to save any changes you have made to the document.  These changes including edits made using Document Clean-up and inserted controls.

Color Scanning XE "Color Scanning"  (Scan Menu item) (C) (in Scanning Settings dialog box) (I).  Determines whether TestTalker scans in color or black and white.  When checked, TestTalker will scan all colored text, art, and photographs in color.  If you do not have a color scanner installed, TestTalker will let you know that color scanning is not possible.  Color scanning and recognition is a much slower process than the standard black-and-white scanning.  It is recommended that you only use this item when saving a document in its original color presentation is desired.  The default for this item is Off, that is TestTalker will not scan in color.

Comment (in Print dialog box).  This includes any additional information about the selected printer.

Context-Sensitive Help:  The type of help accessed from within an open dialog box. Usually a short statement or paragraph describing the function you are seeking help with.

Controls:  The tools used to insert answer blanks into a document, i.e. inserting controls.  May be Fill-in, 3-line, or 8-line Extended Answer, Multiple Choice, or True/False questions.  Accessed by pressing any of the previously named buttons on the toolbar, or accessing Insert file menu. 

Convert Other Lines to Fill-In XE "Convert Other Lines to Fill-In"  (Scanning Settings Dialog box):  The default setting, a check in this box, will tell TestTalker to recognize blank lines as Fill-in answer blanks.  Uncheck the box to tell TestTalker not to insert answer blanks automatically. 

Copies XE "Copies"  (group) (in Print dialog box).  This group contains a place to specify the number of copies to print.

Copy XE "Copy"  (Edit menu item) (C) (CTRL+C).  Use the Copy button to copy selected text.

Correct Word XE "Correct Word"  (in OCR Correction dialog box) (R).  In this field, enter the word the way TestTalker should have recognized it.  Corrections can include spaces.

Crosshair:  The cursor that appears while inserting Multiple Choice and True/False answer buttons.  Answer buttons appear at the center of the crosshair when left mouse button is pressed.

Cut XE "Cut"  (Edit menu item) (T) (CTRL+X).  Use the Cut button to select portions of selected text for removal from the document.

Delete (button) (in Pronunciation Dictionary dialog box) (in OCR Correction dialog box) (D).  Select this button to delete a word and its correction from the word list.  Note that TestTalker will ask you to confirm the deletion.  
Delete XE "Delete"  (Edit Menu item) (D).  Use this menu command to delete selected text or controls.  Selecting a control by clicking on it, or highlighting specific text, then selecting Delete will delete the selected item.

Delete Current Page XE "Delete Current Page"  (Edit Menu item) (CTRL+DEL) (N).  Select this menu command to delete the entire page your cursor is on.  When you select Delete Current Page, TestTalker opens a small dialog box on the screen warning you that page deletion cannot be undone, and asking you to confirm the deletion.

De-skew XE "De-skew"  (in Scanning Settings dialog box) (D).  Using de-skew will correct as much as ten degrees of skew in a crooked page, straightening up to three quarters of an inch for a standard eight-and-a-half inch page.  Use this option if you are concerned that the page is on the scanner slightly crooked, or skewed.  It is also helpful when reading documents that have been photocopied, since the text may not be perfectly straight on the page.  However, de-skewing will add a few seconds to the scan time.  The default for this item is On.

De-speckle XE "De-speckle"  (in Scanning Settings dialog box) (K).  De-speckle corrects for a page that doesn’t have a clean, clear, background, such as a page that has been photocopied several times, newspapers, or text on paper with speckled shading on it, such as colored newsprint or magazines.  The default setting for this item is On.

Dialog Box XE "Dialog Box" :  The box that appears when a menu item followed by an ellipsis (…) is selected. A dialog box contains settings that may be user-specified, for example, naming a file.

Disable Dynamic Zoning XE "Disable Dynamic Zoning"  (Tools, Dynamic Zoning Menu item) (D).  Disables dynamic zoning mode.

Discard Blank Pages XE "Discard Blank Pages"  (in Scanning Settings dialog box) (B).  Check this box is you want TestTalker to throw away scanned pages that are blank.  Note that sometimes you will want to keep blank pages so that you can maintain the original page numbering and order.  The default is unchecked.

Document Clean-up (toolbar button) (Tools Menu item) (D) (F4).  Select this toolbar/menu command to enter document clean-up mode.  In document clean-up mode, you correct OCR errors that may have occurred during scanning.

Dynamic Zoning:  The mode and process by which reading order is changed, and specific text and graphics are ignored. Appears on the Tools menu.

Edit Menu XE "Edit Menu"  (ALT+E).  This menu allows you to edit documents; undo, cut, copy, and paste text; add bold, italic, or underline attributes to text; erase answers; go to a specific page; move a page; and delete pages.

Enable Dynamic Zoning and Show Current Zones XE "Enable Dynamic Zoning"  (Tools, Dynamic Zoning Menu item) (E).  

Enables dynamic zoning mode and shows the current reading zones outlined in blue boxes. 

Enter a page number (in Go To Page dialog box) (E).  Type the number of the page you want to go to.

Erase Answers XE "Erase Answers"  (Edit Menu item) (CTRL+E) (E).  Choose Erase Answers to delete all the answers put in by the teacher when trying out as a student.  Print the document prior to using this command if an answer key is desired.

Erase New Zones XE "Erase New Zone"  (Tools, Dynamic Zoning Menu item) (N).  Select this command to erase user-placed dynamic zones defined prior to the last save.

Exact View:  The exact appearance of the document when it is scanned into the program, which is identical to the original document.  Tests, worksheets, and forms are completed in Exact View.  

Exit XE "Exit"  (File Menu item) (X) (ALT+F4).  Select this menu command to close TestTalker.  When you select Exit, TestTalker asks if you want to save changes to the current document, closes this document, then closes TestTalker and returns to the Windows desktop.

Express Batch Delay XE "Express Batch Delay"  (in Scanning Setting dialog box) (X).  To set the amount of time between one scan and the next when scanning in Express Batch or Express Batch in Background modes, use the arrow keys to choose a value between 0 and 25.  A larger number gives you more time to turn the pages.  When you start TestTalker, Express Batch Delay is set to 0, the shortest amount of delay.

Extended Answer:  A larger answer blank option accessed from the Fill-in Plus button or from the Tools manual. Includes 3-line, and 8-line Extended Answer blanks.

File Menu XE "File Menu"  (ALT+F).  This menu allows you to open, save, and print documents, or quit TestTalker.  

File Name XE "File Name"  (File Open dialog box) (File Save As dialog box) (N).  TestTalker fills in the “File Name” field with the first file that matches your request.  You can arrow through the file list or type the file name.

Files of type XE "Files of type"  (File Open dialog box) (File Save As dialog box) (T).  Use “Files of type” to tell TestTalker to use a different file format, such as a .txt or a .doc file.  The default file format is .ttk files. 

Fill-in (Insert, Fill-in Plus Menu item).  Select this control to insert  Fill-in answer blanks.  Position the cursor at the place in the document you wish to insert the answer blank.  Press and hold the left mouse button, and drag to the right and down slightly.  Let off the mouse button when the fill-in answer blank is the desired size.

Fill-in Plus (toolbar button) (Insert Menu item) (F).  Select this menu command to insert Fill-in, 3-line, or 8-line Extended Answer blanks into the document.  The program may insert a Fill-in answer blank when it recognizes an underline of minimum length..  Currently, this is the only control that may be automatically inserted by the program when the material is scanned.

Floppy Disk:  A storage device for data from a computer.  A floppy disk fits into a computer’s floppy drive.

Font XE "Font"  (Edit Menu item) (F).  Select this menu command to determine which type of font used in fill-in answer blanks. Selecting Font will bring up the “Font Selection for Edit Controls” dialog box.  Pick the desired Font Name, and click OK.

Go XE "Go"  (in Go To Page dialog box) (G).  To go to the page you have typed, click “Go.”

Go To Page (Edit Menu item) (G).  Selecting this command brings up the Go To Page dialog box.  In this box are options for navigating through the open document including going to a specific page number, going to the next page, and going to the previous page.  
Group Buttons (Tools Menu item) (G).  Select this command to manually group multiple choice answer buttons inserted in a document.  After selecting Group Buttons,  position the cursor near the group of buttons to be grouped, click and hold the left mouse button, and drag the selection box over the answers to be grouped.  Release the mouse button and the multiple choice answer buttons are grouped.

Group Cursor XE "Group Cursor" :  The cursor that appears when in Group Buttons mode.  Appears as a small box, made up of a dashed line, with an arrow in the upper left corner.

Help Menu (ALT+H).  This menu gives you access to information for learning and using TestTalker.

Hyperlink XE "Hyperlink" :  A link that allows the user to jump directly to a related topic by clicking on the link.  Represented by blue text.

Insert Menu (ALT+I).  This menu allows you to insert answer blanks, also known as controls into the document.

Insertion Cursor XE "Insertion Cursor" :  The cursor that appears when inserting controls.  Appears as a red crosshair.

Key Echo During Editing XE "Key Echo During Editing"  (in Speech Settings dialog box (K).  To tell TestTalker to speak your typed keystrokes out loud when you are in the Text-only View window of Document Clean-up mode.  Enter your selection or use the arrow keys.  This spoken “echo” of your keystrokes allows you to hear your typing as you type.  You have six options: Off Character, Word, Both Character and Word, and Sentence.  The default setting is Both Word and Sentence, so TestTalker will repeat each word after you type it, and then repeat the entire sentence after you finish it.

Landscape XE "Landscape"  (in Print Setup dialog box) (A).  Prints the document so that the long edge of the paper is at the top of the page.

Left Boundary (in Scanning Settings dialog box) (L).  The Left, Right, Top, and Bottom boundaries determine how much of the page TestTalker should recognize, by defining the distance from the side of the page.  This tells TestTalker to ignore anything outside that boundary.  The standard setting for all four boundaries (left, right, top, and bottom) is zero, which means that the entire page will be scanned and recognized.

Maltese Cross:  The cursor that appears when a cursor is positioned over a created answer blank or button.  Enables the user to reposition the answer blank or button.

Manual (Insert, Multiple Choice Menu item) (M).  Manual insertion of multiple choice answer buttons allows the student to select more than one answer in a group of possible answers.  Answer buttons may be grouped manually using the group buttons option on the tools menu.  Select this option, position the cursor near the group of buttons to be grouped, click and hold the left mouse button, and drag the selection box over the answers to be grouped. Release the mouse button and the multiple choice answer buttons are grouped.
Margins XE "Margins"  (group) (in Print Setup dialog box).  The entry fields in the “Margins” group (Left, Right, Top, Bottom) allow you to change any of the four margins on the page.

Menus:  Drop-down menus accessed through a programs file menu located in the words listed along the top of the program. They contain the commands and settings used by the program.

Minimum Number of Underlines for Conversion XE "Minimum # of Underlines for Conversions"  (Scanning Settings dialog box).  Use this command to control how TestTalker recognizes and inserts Fill-in answer blanks into a document.  The options, from 1 to 9, tell TestTalker the minimum number of spaces a blank line must be before it will recognize it as an answer blank.

Mis-identified Word XE "Mis-identified Word"  (in OCR Correction dialog box) (M).  Enter the 

word that TestTalker has not recognized correctly in this field.  TestTalker’s OCR Correction feature only looks for whole words.  It will ignore any spaces you try to enter.  It will recognize punctuation.  Punctuation characters are some of the most common mis-identified ones.

Move Down One Page (button) (in Move Page dialog box) (D).  Moves the current page back one page in the document.  Once TestTalker moves the page, it will tell you the current page’s new page number.  Please note that all other pages in the document will be renumbered as necessary to accommodate the moved page.

Move Page XE "Move Page" …(Edit Menu item) (O).  Select this menu command to move the current page to another location in the document.  When you select Move Page, TestTalker opens the Move Page dialog box.  You can move a page to a specific place, or you can move it to the previous, next, top, or bottom of the document.  Once TestTalker moves the page, it will tell you the current page’s new number.  Please note that all other pages in the document will be renumbered as necessary to accommodate the moved page.  Note that if the open document does not contain more than one page, this item is not available. 

Move to Bottom (button) (in Move Page dialog box) (B).  Moves the current page to the end of the document.  Once TestTalker moves the page, it will tell you the current page’s new page number.  Please note that all other pages in the document will be renumbered as necessary to accommodate the moved page.

Move to Page (button) (in Move Page dialog box) (T).  Type in the page number  where you wish to move the current page.  Or type in the relative position you want to move to.  For example, if you are on page10 and you want to move the page to page 8, you can enter –2 to move back 2 pages.  You can move the page ahead 2 pages by typing +2.  When you have entered the page number, press the “OK” button and TestTalker will move the page.  Once TestTalker moves the page, it will tell you the current page’s new page number.  Please note that all other pages in the document will be renumbered as necessary to accommodate the moved page.

Move to Top (button) (in Move Page dialog box) (T).  Moves the current page to the beginning of the document.  Once TestTalker moves the page, it will tell you the current page’s new page number.  Please note that all other pages in the document will be renumbered as necessary to accommodate the moved page.

Move Up One Page (button) (in Move Page dialog box) (U).  Moves the current page forward one page in the document.  Once TestTalker moves the page, it will tell you the current page’s new page number.  Please note that all other pages in the document will be renumbered as necessary to accommodate the moved page.

Movement Cursor XE "Movement Cursor" :  The cursor that appears when you are not inserting controls.  Appears as an arrow.

Multiple Choice (Insert Menu item) (M).  Select this control to insert multiple choice answer buttons into a document.  You may choose to insert multiple choice answer buttons manually, or by using Auto-group 4.  Multiple choice buttons inserted manually allow a student to select more than one answer in a group of questions, unless grouped manually using the Group Buttons function on the Tools menu.  Using Auto-group 4 allows the student to select only one answer in a group of four possible answers.  Insert multiple choice answer buttons by positioning the cursor where you want the answer button inserted, and pressing the mouse button.  Repeat for each possible answer in a group of answers. 

Name (in Print dialog box) (N).  This is where you can select which printer you want to print your document.  The printer selected becomes the default printer for the rest of the session unless changed.

New (tool bar button) (File Menu item) (CTRL+N) (N).  Select New to create a new document.  When you select New, TestTalker opens a blank document.  You scan pages into this document and save it under a new name.  
Next Page (in Go To Page dialog box) (N).  Click “Next Page” to go directly to the next page in the document.

Next Page (in Print Preview dialog box) (N).  Click “Next Page” to view the next page in the document.

OCR Correction Editor XE "OCR Correction Editor"  (Tools Menu item) (O).  Use OCR Correction to correct any words that TestTalker’s OCR engine has not correctly identified.  TestTalker’s OCR engine usually does a very good job of identifying text correctly.  However, due to a wide range of type styles, fonts, and reproduction quality for documents you are likely to encounter, not all words will be correctly identified with every scan.  Using TestTalker’s OCR Correction feature, you can apply corrections for any text string to your document.  To make changes to the OCR text, the user opens the OCR Correction Editor. Within the OCR Correction dialog box; click the Add button to add a word to the Word List, then click “Apply to Current Document.”  The changes will be applied to the current document.  

OK (ENTER) (O).  Saves the changes specified and closes the dialog box. 

On-line Help:  A type of help used by TestTalker.  Requires Microsoft Internet Explorer 4.0 or greater. Accessed from the Help menu.

Open (toolbar button) (File Menu item) (in Select a file to open dialog box) (CTRL+O) (O).  Select Open to open a document.  Selecting open brings up a dialog box titled “Select a file to open.”  Use this dialog box to choose a file to open.  Use “Look in” to tell TestTalker what folder to look in to fin the file you want to open.  The default location is the /Docs folder in the TestTalker Teacher directory.  Use “Files of type” to tell TestTalker to open a different file format, such as a .pdf file.  TestTalker does not support files that are not in .pdf or the default file format, .ttk. 

Open/Save (button) (File Open dialog box) (File Save As dialog box) (O) (S).  Opens/Saves the file with name, file type, and location specified.

Optical-Character Recognition (OCR):  The software that converts images scanned into the computer as letters and numbers.

Page Orientation XE "Page Orientation"  (in Scanning Settings dialog box) (P).  Use this setting to specify the orientation of the page on the scanner.  Automatic lets TestTalker determine which way the page is situated on the scanner.  This is the easiest setting, but it can add slightly to the scanning time.  Normal means the top of the page is flush with the edge of the scanner glass that the scanner says is the top.  Sideways means the top of the page is flush with the scanner glass side that is to the right of the scanner’s top.   Upside-down means the top of the page is flush with the opposite edge of the scanner’s glass plate.  Sideways Upside-down means the top of the page is flush with the scanner glass side that is to the left of the scanner’s top.  The default setting for this item is Automatic Orientation.

Paper Size XE "Paper Size"  (in Print Setup dialog box) (Z).  The “Paper Size” entry field in the Paper group lists all the paper sizes supported by your printer, and indicates which size is currently selected.  To select a different size, type in the name or select it from the list using the arrow keys.

Paper Source XE "Paper Source"  (in Print Setup dialog box) (S).  The “Paper Source” entry field in the Paper group lets you choose the printer tray or feeder.  Use the arrow keys to select the printer tray from which you want to print the document.

Paste (Edit Menu item) (CTRL+V) (P).  Select Paste to insert text that you have previously put in the Microsoft Windows clipboard, into your document.  You can only use this item if you have already cut or copied text into the Clipboard.  You can paste the text into another part of the open document, or into another document.  You can also paste text into another application, such as Microsoft Word, by using the hotkeys or using that application’s Paste function.  Find the location where you want the text inserted, then select Paste.  The text is inserted into the document.  Note that this item is only available when you are in Document Clean-up mode and there is already text in the Clipboard or in an answer blank in Student Mode.

PDF XE "PDF" :  Adobe® Portable Document Format, is a common file format specific to graphics.  TestTalker is able to import PDF files.  The PDF file must be printed from the originating program to TestTalker’s Virtual Printer.  TestTalker displays PDF files in 600 x 600 dpi resolution.  This format is too big for TestTalker to display in its window, and a scrollbar will appear at the bottom of the screen.  To make the PDF document appear completely within the TestTalker window, go to the TestTalker Virtual Printer Properties, and select Graphics or Advanced.  Change the Print Quality from 600 to 300 dpi.

Pitch XE "Pitch"  (in Speech Settings dialog box) (P).  To select how high or low the voice reads, move the slider to the left or right.

Portrait XE "Portrait"  (in Print Setup dialog box) (O).  Prints the document so that the short edge of the paper is at the top of the page.

Previous Page (in Go To Page dialog box) (P).  Click “Previous Page” to go directly to the previous page in the document.

Previous Page (in Print Preview dialog box) (V).  Click “Previous Page” to view the previous page in the document.

Print (tool bar button) (File Menu item) (CTRL+P) (P).  Select Print to print the active document.  When you select Print, TestTalker opens the Print dialog box.  The printed copy of your file will reflect the controls and settings you have chosen.  If you do not have a document open to print, this item will not be available.

Print Preview (File Menu item) (V).  Select this menu command to preview how the document will print with the inserted controls.  Selecting Print Preview views the document in TestTalker’s Print Preview mode.  From this mode, you may print, go from page to page, or zoom in or out. 
Print Range XE "Print Range"  (group) (in Print dialog box).  This group of commands contains radio buttons that are used to select which part of the document to print.  The options are: All Pages and Pages from X to Y (where you specify the range).

Pronunciation XE "Pronunciation"  (in Pronunciation Dictionary dialog box) (P).  You enter the correct pronunciation for the word in this field.  Pronunciations can include spaces.  Sometimes inserting a space between letters helps with placing the stress on the correct syllable, and with pronunciation of vowels.

Pronunciation Editor (Tools Menu item) (R).  This command brings up a dialog box in which you enter the correct pronunciation for a word.  Pronunciations can include spaces.  Sometimes inserting a space between letters helps with placing stress on the correct syllable, and with pronunciation of vowels.

Properties XE "Properties"  (File Menu item) (CTRL+R) (R).  Select Properties and information is displayed about the document you currently have open. Information includes the Document Name, Document Type, MS DOS Name, Document Location, Document Size, Date Created, Last Modified, and Last Accessed.

Properties (in Print dialog box) (P).  This command allows access for changing several printing properties including type of paper, graphics, orientation, and paper source.
Rate XE "Rate"  (in Speech Settings dialog box) (R).  To select how fast TestTalker reads, move the slider to the left or right.  The default is 150 words per minute for the ViaVoice speech software included with TestTalker.

Recognize Columns (Scan Menu item) (in Scanning Settings dialog box) (Z).  Determines how TestTalker will scan, save, and present your document for reading.  When Recognize Columns is checked, TestTalker saves and reads all of column one first, then column two, and so on.  If it encounters tables, TestTalker is smart enough to automatically present them properly.  When Recognize Columns is not checked, TestTalker will scan, save, and present the entire page as though there were no columns.  Most of the time column recognition is the best choice.  Turing this option off may increase TestTalker’s ability to recognize and insert fill-in answer blanks automatically.  The default for this item is Off.

Re-define Zones on Current Page XE "Re-define Zones on Current Page"  (Tools, Dynamic Zoning Menu item) (R).  Selecting this menu command allows the user to redefine the reading order of the page of a document.    

Re-recognize Document XE "Re-recognize Document"  (Tool, Dynamic Zoning Menu item) (E).  Selecting this menu command tells TestTalker’s OCR engine to re-recognize the current document.  Note that while reading order will be preserved, OCR errors that occurred during the initial scanning process may occur again.

Revert to Original Zones XE "Revert to Original Zone"  (Tools, Dynamic Zoning Menu item) (O).  Selecting this menu command allows the user to revert to the original reading order specified by TestTalker when the document was scanned into the program.

Right Boundary (in Scanning Settings dialog box) (R).   The Left, Right, Top, and Bottom boundaries determine how much of the page TestTalker should recognize, by defining the distance from the side of the page.  This tells TestTalker to ignore anything outside that boundary.  The standard setting for all four boundaries (left, right, top, and bottom) is zero, which means that the entire page will be scanned and recognized.

Save (tool bar button) (File Menu item) (CTRL+S) (S).  Select Save to save the document you are currently working in without closing it.  When you select save TestTalker automatically saves the document.

Save As…(tool bar button) (File Menu item) (A).  Select Save As to save your open document.  Pressing this button brings up a dialog box. Use this dialog box to save the active file with a different file name or file format.  Use “Look in” to tell TestTalker what folder you want to save your file in.  The default location is C:\TestTalk\Teacher\Users\Shared\Docs.

Scan and Replace Current Page XE "Scan and Replace Current Page"  (Scan Menu item) (R).  Select this menu command, when you are in a scanned document, to scan a page and have it replace the current scanned page.  Note: if using the 2-page scanning mode, this item replaces both the current and the next scanned pages in the document.

Scan Menu (ALT+S).  This menu lets you control how TestTalker scans and displays the page after scanning it.  If you do not have a scanner installed, items on this menu may not be available.  In addition to the items on the scan menu, TestTalker provides a number of other ways to scan and read text, all of which can be set using the Scanning Settings, located in the Tools menu.

Scan Page (Scan Menu item) (F3) (S).  Select this menu command to begin scanning the page you have placed on the scanner.  Place the page on the scanner first, then begin scanning.  While the page is being scanned, a dialog box informs you that TestTalker is processing the page.  To interrupt scanning, you can press the Cancel button on this dialog box; however most other buttons and menu items will be unavailable.  There may be a slight delay before TestTalker interrupts the scanning procedure with messages in this dialog box.  Once scanning is done, TestTalker displays the scanned page on your screen in Exact View.  When you scan subsequent pages, they are inserted after the page your cursor is on.

Scanner XE "Scanner"  (Scanner Selection dialog box) (S).  Select this command to choose which scanner you want TestTalker to use to scan the document.  The choice is limited to the scanners you have installed on your computer.

Scanner Selection XE "Scanner Selection"  (Scan Menu item) (S).  Select this menu command to specify what type of scanner driver you want TestTalker to use.  Several choices may exist depending on how many scanners are installed in your system.  TestTalker automatically detects the scanner drivers that are installed on your computer, and selects the one it thinks you will want to use as the default.  If there does not appear to be an obvious scanner choice, TestTalker will display this item the first time you scan a document, and ask you to confirm the scanner driver selection.  Note that we do not recommend using the HP TWAIN driver unless you are using one of the HP 3200-4300 series scanners due to its slow speed.

Scanning Contrast XE "Scanning Contrast"  (in Scanning Settings dialog box) (C).  Use Scanning Contrast to control the dark-to-light contrast ratio in the scanned document.  You have several choices.  Using Automatic Contrast XE "Automatic Contrast" , TestTalker will individually evaluate each page to determine the best contrast setting for maximum accuracy.  This is the easiest setting, but it adds to the scanning time.  Normal Contrast XE "Normal Contrast"  works for most books and memos, or anything else that has a reasonably good black print on white paper.  Darken Page XE "Darken Page"  is useful when the print on the page is too light.  When TestTalker reads a light page, letters seem to “break up.”  An example of this is when TestTalker reads “iii” instead of the letter “m.”  Lighten Page XE "Lighten Page"  is a good choice if the letters are becoming “glued together.”  An example is when TestTalker reads the letter ‘m’ instead of the letters ‘r’ and ‘n.’  You can fine tune the contrast level using Custom Contrast XE "Custom Contrast" , which has numbers form 0 to 16.  The darkest value is 0, and the lightest value is 16.  Darken Page is equivalent to the value of 4, Normal Contrast is 8, and Lighten Page is 12.  The default setting for this item is Automatic Contrast.

Scanning Hotkey XE "Scanning Hotkey"  (in Scanning Settings dialog box) (H).  Use this command to specify the key combination that you can use to scan a document from within another program.  The key combination must be CTRL+ALT along with an alphanumeric key (a letter or number).  When you press the scanning hotkey from outside TestTalker (that is when TestTalker is running, but not the active program), TestTalker will scan the page using Scan in Background mode and place it at the end of the active document in TestTalker.  The default setting is CTRL+ALT+S.

Scanning Mode (in Scanning Settings dialog box (S).  Use this setting to select one of several different ways to scan documents.  There are many scanning modes available.  Scan and Read XE "Scan and Read"  lets you first scan a page and read it.  Scan in Background XE "Scan in Background"  lets you scan one page while reading another.  The document you are scanning may be the same as the document you are reading, or you may scan into one document, then open and read another.  While TestTalker reads the page, you’ll hear a musical tone, your signal that TestTalker is ready to scan another page.  Place a second page on the scanner, then press the Scan key.  TestTalker will continue to read while the second page is being scanned.  Note that his mode is not recommended unless you have a hardware synthesizer, such as DECtalk PC or DECtalk Express.  Otherwise, speech is interrupted during scanning.  Large Batch lets you divide the scanning process into two parts:  Scanning the page, and Processing and Recognizing the page.  Scanning requires your participation to turn the pages.  But Processing and Recognition—the lengthier procedures—can be done by the computer without your involvement.  Using Large Batch, you can scan all the pages of a large document—like a book—then instruct TestTalker to process the pages while you do something else.  You don’t have to be present during the processing step.  If you are using an Automatic Document Feeder XE "Automatic Document Feeder"  (ADF), the process is even more automated.  You can place batches of 20 to 25 pages in the ADF, and scan them as a group.  Please note that if you are using 2-page scanning with ADF, you must scan the backs of the pages in reverse order so TestTalker can match them up correctly.  Batch in Background XE "Batch in Background"  allows you to begin Large Batch scanning, and while you are scanning, open and read a document.  Express Batch is a simpler version of Large Batch scanning.  While Large Batch gives you prompts when it has completed scanning and is ready for another page, Express Batch skips these prompts.  You must listen for the sound of the scanner head reaching the bottom of the flatbed and returning to the top.  In those few seconds it takes to do this, place a new page on the scanner.  Express Batch is best used by a person who is familiar with their scanner, and wants to scan a large document quickly.  Do not use this mode with an ADF.  Express Batch in Background XE "Express Batch in Background"  combines background scanning with Express Batch.  Image Only XE "Image Only"  scans the page and saves it as an image file, without performing the recognition process.  This setting is useful if you wish to create an image file to be faxed later or used as a graphic.  Process Image Files XE "Process Image Files"  allows you to recognize image files, such as files you have received via a fax card or files you have scanned in, but not processed.  For the best possible recognition, be sure to get a fine fax image of 200 x 200 dpi, and save the file in TIF format.  When you choose this scanning mode, you will need to tell TestTalker where to find the file you wish to recognize.  The default scanning mode is Scan and Read.   
Scanning Options (Tools Menu item) (S).   Select this command to show the Scanning Options dialog box, which enables you to control the way TestTalker scans pages.  Options exist for scanning mode, scanning contrast, orientation, and a number of fine-tuning functions. Changing scanning options when a document with inserted controls is open may appear to change the positions of the controls.  Close the document and reopen it, or go to a different page, then back, and the controls will reappear in the original locations.

Scanning:  The process by which a scanner “copies” a document or picture into a computer.

Search for help on (Help Menu item) (S).  This menu command allows you to search TestTalker’s help files for a specific subject.

Select All (Edit Menu item) (CTRL+A) (S).  Select this menu command to select all the text on the current page.  Once you have selected all the text, you can Cut, Copy, or Delete it.  Note that unlike many programs, TestTalker’s ‘Select All’ command selects only the text on the current page, not in the entire document.

Speak Menus and Dialogs (Speech Settings dialog box).  Check this box to have TestTalker  speak all menu items and dialog box controls when your cursor lands on them.  The default for this option is unchecked.

Speak Toolbar Buttons (Speech Settings dialog box).  Check this box to have TestTalker speak the tool tips for the toolbar buttons.  The default for this option is unchecked.

Speech Options XE "Speech Options"  (Tools Menu item) (P).  Select this command to show the Speech Options dialog box, which enables you to control the way TestTalker, speaks documents.  Options exist for type of voice, volume, pitch, rate of speech, and other settings.  
Start Reading XE "Start Reading"  (Tools Menu item) (S) (F2) (Spacebar).  Select this menu command to have TestTalker begin reading from the cursor position.

Status (in Print dialog box).  This describes the state of the selected printer, such as busy, idle, ready, or default printer.

Student Edition:  The module of TestTalker that the student uses to complete a test, form, and/or worksheet created by the teacher using the Teacher Edition.  A test-taking program.  Requires the Teacher Edition.

Student/Teacher Mode:  This option allows the teacher switch between Teacher Mode (for creating the test) and Student Mode (for trying out the test as a student).  The Student Mode may also be used to create an answer key.  Access this option by selecting Student/Teacher Mode from the toolbar or by selecting Check As Student from the Tools menu.

Teacher Edition:  The module of TestTalker that the teacher uses to scan in, and insert controls (answer blanks) into a test, form, and/or worksheet.  A test-creating program.

Test XE "Test"  (button) (in Pronunciation Dictionary dialog box) (T) (in Speech Settings dialog box) (E).  You can use the test button to test the pronunciation of a word before you add it to the Pronunciation Dictionary.  You can also use the Test button to check the pronunciation of a word already on the list.  In the Speech Settings dialog box, you can select Test to hear your changes before making them permanent.

TestTalker Help (Help Menu item) (H) (F1).  This menu command opens TestTalker’s on-line help system.

TestTalker:  Developed by the Learning Systems Group of Freedom Scientific, Inc., TestTalker is a test creating and test-taking program.   Tests, forms, and/or worksheets are scanned into TestTalker.  TestTalker is then able to speak the materials and allows their completion using a computer.  File extensions are designated .ttk.

Toolbar:  The collective group of icons located at the top of the program. Provides primary access to TestTalker’s features.

Tools Menu (ALT+T).  Use this menu to control both scanning and speech options, start reading, enter document clean-up, use the OCR correction editor, pronunciation editor, word count, group buttons, and align buttons.
Top Boundary (in Scanning Settings dialog box) (T).  The Left, Right, Top, and Bottom boundaries determine how much of the page TestTalker should recognize, by defining the distance from the side of the page.  This tells TestTalker to ignore anything outside that boundary.  The standard setting for all four boundaries (left, right, top, and bottom) is zero, which means that the entire page will be scanned and recognized.

True/False (toolbar button) (Insert Menu item) (T).  Use this control to insert true/false answer buttons into a document.  Note that true/false answer buttons are automatically grouped, meaning that only one answer may be selected.  Insert a true/false answer button by positioning the cursor where desired, and pressing the mouse button.  Repeat to insert the second true/false answer button.

True/False:  The controls used when inserting true/false answer buttons.  Select the True/False button from the toolbar or select True/False from the Insert menu.  Insert by pressing the mouse button.

Twain Properties XE "Twain Properties"  (in Scanner Selection dialog box) (group).  If you are using the Unknown TWAIN driver selection in the Scanner field, you can fine-tune TestTalker’s operation with your scanner.  Note that you should not use the ‘Unknown TWAIN’ choice unless the other choices do not work with your scanner.  Three checkbox items exist for this.  ‘Allow scanner to finish when canceling a scan,’ ‘Black and white contrast uses Brightness instead of Threshold,’ and ‘Must close TWAIN after each scan.’  See the individual entries for each item for tips on when to use them.  The default setting for each item is unchecked.  You should only select an item if you are having problems that you think one of these will solve.

Two Page XE "Two Page"  (in Print Preview dialog box) (T).  Click ‘Two Page’ to simultaneously view two pages in the document.

Type (in Print dialog box).  This tells the type and official name of the selected printer.

Undo (Edit Menu item) (CTRL+Z) (U).  Undo allows you to remove the effect of the last edit you performed, whether it was typing or deleting text, or inserting controls.  Note that Undo only undoes the last change you have made.

Virtual Printer XE "Virtual Printer" :  An option that allows the importation of various file formats into TestTalker.  Appears as an installed printer on a users computer.  Certain files printed to TestTalker’s Virtual Printer can be imported and recognized by TestTalker.

Voice XE "Voice"  (in Speech Settings dialog box) (V).  Lists voices available for use by TestTalker.  Type in your selection or use the arrow keys.

Volume XE "Volume"  (in Speech Settings dialog box) (U).  To select how loud TestTalker reads, move the slider to the left or right.

Where (in Print dialog box).  This identifies the location of the selected printer and what printer port it is using.

White on Black XE "White on Black"  (in Scanning Settings dialog box) (W).  This setting allows TestTalker to scan and recognize white text on a black background.  This is useful when scanning magazines that open use light text on a dark background for emphasis.

Word (in Pronunciation Dictionary dialog box) (W).  You enter the mispronounced word in this field.  TestTalker only looks for whole words.  It will ignore any spaces you try to enter.  It also ignores punctuation, so it will pronounce ‘it’s’ and ‘its’ the same way.

Word Count XE "Word Count"  (Tools Menu item) (W).  Select this menu command to have TestTalker tell you how many words are in the current document.

Word List XE "Word List"  (in Pronunciation Dictionary dialog box) (in OCR Correction dialog box) (L).  This is a list of words available to specify for OCR correction.  Press the mouse or arrow keys to advance to the first word in the list.

WYNN:  Freedom Scientific’s innovative reading, writing, and studying program.   

Zoom In XE "Zoom In"  (in Print Preview dialog box) (I).  Click ‘Zoom In’ to zoom in on specific parts of the document.

Zoom Out XE "Zoom Out"  (in Print Preview dialog box) (O).  Click ‘Zoom Out’ to view the whole page of a document.  

Keystrokes XE "Keystrokes" 
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Ctrl+B

--
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Copy
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Erase Answers
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Ctrl+K

--

Ctrl+L
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Ctrl+N
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Ctrl+O
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Ctrl+P
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Ctrl+Q
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Ctrl+R
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Save

Ctrl+T
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Ctrl+U

--

Ctrl+V

Paste

Ctrl+W
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Ctrl+X

Cut

Ctrl+Y
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Ctrl+Z
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Ctrl+DELETE
Delete Current Page

Ctrl+Tab
Switch Documents
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Help

F2
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F3

Scan

F4
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F5
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F6

Insert Fill-in
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Insert Multiple Choice

F9

Insert True/False
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--
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Show Right-click menu

Index



2-Page Scanning, 41

3-line Extended Answer, 28

8-line Extended Answer, 28

Add, 41

Align answer blanks, 30

Align Answer Blanks, 30

Align Left, 30

Align Top, 30

Apply to Current Document, 42

Auto-Group 4, 26

Automatic Contrast, 58

Automatic Document Feeder, 60

Batch in Background, 60

Boundary, 42

Cancel, 42

Case Sensitive, 42

Check As Student, 43

Clean-up, 21

Close, 11, 43

Color Scanning, 43

Context-Sensitive Help, 6

Controls, 24

Convert Other Lines to Fill-In, 44
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Delete, 45

delete an answer blank, 29

Delete Current Page, 45
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Erase Answers, 46
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Exact View, 21
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Express Batch Delay, 47
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File Menu, 47
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Insertion Cursor, 49
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Interface, 9
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Materials to use, 7

Menus, 14
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Save, 11

Saving to Disk, 35
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